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How to Use This Book

Who Needs This Book

This book is for the reader who has never used this
particular technology or software application. It is also for
readers who want to expand their knowledge.

The Conventions in This Book

Steps

This book uses a step-by-step format to guide you easily
through each task. Numbered steps are actions you must
do; bulleted steps clarify a point, step, or optional feature;
and indented steps give you the result.

Notes

Notes give additional information — special conditions
that may occur during an operation, a situation that you
want to avoid, or a cross reference to a related area of
the book.

lcons and Buttons
Icons and buttons show you exactly what you need to
click to perform a step.

Tip and Warning Icons

Tips offer additional information, including tips, hints, and
tricks. You can use the tip information to go beyond what
you have learned in the steps. Warmnings tell you about
solutions to common problems and general pitfalls to
avoid.

Bold
Bold type shows command names, options, and text or
numbers you must type.

[talics
Italic type introduces and defines a new term.
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WORKING WITH EXCEL

You use Microsoft Excel to create spreadsheets, which are
documents that enable you to manipulate numbers and
formulas to quickly create powerful mathematical, financial,
and statistical models. In this chapter; you learn about Excel
and you find out the kinds of tasks you can perform with
Excel.You also learn how to start the program and you take
a tour of the program’s major features. This chapter also
shows you how to work with the Excel Ribbon, how to
customise the Ribbon and the Quick Access Toolbar, how to
work with smart tags, and how to customise the view and
other aspects of the program.




GETTING TO KNOW EXCEL
-

Working with Excel involves two basic tasks: building a spreadsheet and then manipulating
the data on the spreadsheet. Building a spreadsheet involves adding data, formulas, and
functions. Manipulating data involves calculating totals, working with series, creating tables for
your data, and visualising data in charts.

This section gives you an overview of these tasks. You learn about each task in greater detalil
as you work through the book.

. .

Build a Spreadsheet

Add Data -

You can insert text, numbers, and other characters into any cell in the |, Loan Data

spreadsheet. Click the cell that you want to work with and then type ~ |?  AmnualinterestRate  6,00%
) o 3 Amortization (in years) 15

your data in the Formula bar. This is the large text box above the 4 Loan Princlpal $500,000

column letters. Your typing appears in the cell that you selected. :

When you are done, press [ZiZ3. To edit existing cell data, click the

cell and then edit the text in the Formula bar.

Add a Formula

A formula is a collection of numbers, cell addresses, and mathematical
operators that performs a calculation. In Excel, you enter a formula in
a cell by typing an equals sign (=) and then the formula text. For
example, the formula =B 1-B2 subtracts the value in cell B2 from the
value in cell BI.

Add O FunC‘hon 1 .Pru;uut Dele‘cts D:ltanhase( .
. . . 2 | Workgroup | Group Leader Dll“tl! Units % Defective
A function is a predefined formula that performs a specific task. For T T
example, the AVERAGE function calculates the average of a list of | ) B =
. 7 E Durbin S 767 1%
numbers and the PMT function calculates a loan or mortgage § el qCDmene o ol

payment. You can use functions on their own, preceded by =, or as
part of a larger formula. Click Insert Function ([£]) to see a list of
the available functions.
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Manipulate Data

Calculate Totals Quickly Z
If you just need a quick sum of a list of numbers, click a cell below the numbers and then

click the Sum button ([z]), which is available in the Home tab of Excel's Ribbon. You can

also select the cells that you want to sum and their total appears in the status bar.

Fill a Series

Excel enables you to save time by completing a series of values automatically.
For example, if you need to enter the numbers | to 100 in consecutive cells,
you can enter just the first few numbers, select the cells, and then click and drag
the lower right corner to fill in the rest of the numbers. Most programs also fill
in dates and the names of week days and months.

Manage Tables

The row-and-column format of a spreadsheet makes the program
suitable for simple databases called tables. Each column becomes
a field in the table and each row is a record. You can sort the
records, filter the records to show only certain values, and add
subtotals.

Add a Chart

A chart is a graphic representation of spreadsheet data. As
the data in the spreadsheet changes, the chart also changes
to reflect the new numbers. Excel offers a wide variety of
charts, including bar charts, line charts, and pie charts.
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START EXCEL

Before you can perform tasks such as adding data and building formulas, you must first start
Excel. This brings the Excel window onto the Windows desktop and you can then begin
using the program. This task and the rest of the book assume that you have already installed
Excel 2010 on your computer.

When you have finished your work with Excel, you should shut down the program. This
reduces clutter on the desktop and in the taskbar, and it also conserves memory and other
system resources.

\. J

() Click Start.
The Start menu appears.

e Click All Programes.

The App Programs menu appears.

e Click Microsoft Office.

G CHAPTER 1 WORKING WITH EXCEL D



The Microsoft Office menu
appears.

e Click Microsoft Excel 2010.

The Microsoft Excel window
appears on the desktop.

Tookd - Micsosoht Eucel
¢ | wun Pagensud  Formulsk  OMa Revew  View

Gengral = (J§ Conamional Formating = Z*Inuert =

Note: When you are finished with Excel, .- L F TN W wo-

it

close the program by clicking the File tab and
then clicking Exit.

y
/

@ After you have used Excel a
few times, it should appear on
the main Start menu in the list
of your most-used programs
and you can click that icon
to start the program.You can
force the Excel icon onto
the Start menu by following
Steps | to 3, right-clicking the
Microsoft Excel 2010 icon and
clicking Pin to Start Menu. If
you are using Windows 7, you
can click Pin to Taskbar to
add the Excel icon to the
taskbar.
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TOUR THE EXCEL WINDOW

~\
To get up to speed quickly with Excel, it helps to understand the various elements of the
Excel window. These include standard window elements such as the title bar and status bar,
as well as Office-specific elements such as the Ribbon and the File tab.
. J
@ Title Bar A
@ ’“’lm‘“‘ Sy s ::nl =+ R conationai Fomatting +  S~Tent -

The title bar displays the name of the

current workbook.

Quick Access Toolbar

This area gives you one-click access to

a few often-used features. To learn
how to customise this toolbar, see
“Customise the Quick Access
Toolbar.”

@ Excel Window Controls

You use these controls to minimise,

maximise, restore and close Excel’s
application window.

Workbook Window
Controls

You use these controls to minimise,

maximise, restore, and close the
current workbook window.

@ File Tab
Click this tab to access file-related

commands, such as Save and Open.

- -

e EE AT e Pt i Table - ot - o

BIU- @ S A EWEER & ‘3 [T Epemst s G-
bt 3 . s can

i & 8 c 0 E F [ H ! 1
1]
2

z
w

.;=:n==5-oa~

-
Shoekl - Shists | Shaets  oa mo] u Il

\:h R 100% -

(@ Ribbon

This area gives you access to all of Excel's commands,
options and features. To learn how to use this element,
see “Work with Excel's Ribbon.”

@ Worksheet

This area displays the current worksheet and it is where
you will do most of your Excel work.

@ status Bar

This area displays messages about Excel's current status,
the results of certain operations and other information.
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WORK WITH EXCEL'S RIBBON

~\
You use Excel's Ribbon element to access all of the program’s features and commands. The
Ribbon is the horizontal strip that runs across the top of the Excel window, just below the
title bar. The Ribbon is organised into various tabs, such as File, Home and Insert, and each
tab contains related controls, which usually include buttons, lists, and check boxes. There is
no menu bar in Excel, so you do not use pull-down menus to access commands.

\ J
Click the tab that contains the ﬁ-’ﬂ-.»ww_ T e L — e
Excel feature you want to work S ;"; .48 ; Z’j“ .' E“:;?'M P A
Wlth - M = fo — Soament 6| i sy com Fating .

g A] B e o E F G H ] 1 [3 L M‘:—
- —
;
4
: :
7
5
5 i
:.’:
15| .
W4 v W] Sheetl , ‘Shesd | Shestd % uER! - ==l
Mooy | 51 | | R e (o) i i)
Excel displays the controls in N —
the tab. T2k
@ Each tab is organised into i L
groups of related controls, and ‘ A
the group names appear here. -_-m!
--Aa - |m
In - many groups you can click -ﬁ"‘- o '
the dialog box launcher button 2 |
([£) to see group settings. ﬂ--ﬂ
. R recermermne i : g
Click the control for the feature. e RN

e If the control displays a list of
options, click the option you
want.

Excel runs the command or sets
the option.
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CUSTOMISE THE QUICK ACCESS TOOLBAR

.

You can make Excel easier to use by customising the Quick Access Toolbar to include the
Excel commands you use most often. You run Quick Access Toolbar buttons with a single
click, so adding your favourite commands saves time. By default, the Quick Access Toolbar
contains three buttons, Save, Undo and Redo, but you can add any of Excel's hundreds of

commands.

Since there is only so much room for the Quick Access Toolbar in Excel's menu bar,
consider moving the Quick Access Toolbar below the Ribbon to gain more space for your

custom commands.

J

() Cdlick the Customize Quick

Access Toolbar button ([).

@ If you see the command you
want, click it and skip the rest
of the steps in this section.

Click More Commands.

The Excel Options dialog box
appears.

Excel automatically displays
the Quick Access Toolbar tab.

Click the Choose commands
from [].

Click the command category you
want to use.

b Data Revew

¢

7| nasa
S dscrnding
Sor Descending
Open flecerd File

e Belowthe Aibbsn a

More Commandi..

View
Genenl
$ -

G

Boold - Micresoft Excel

1« Elcendtiensl Fomatting ~ G tnsert -
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= Sortd Find &
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Zustomize Ribbol
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Popuasr Commangy

g_] Customize the Quack Access Tool

| Popuar Commindi
Commands Ned in the Ribbon

‘Smartart Teols | Design Tab
| Smartdrt Tools | Format Tab
Chart Teols | Dessgn Tab
Chart Teali | Lapoud Tab
| Chart Teols | Format Tab:
Drawing Tosis | Farmat Tab
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- PeroiTable Tools | Options Tab.
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|Meader & Foster Taok | Design Tab
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- - - =
Click the command you want e = _ W
.to add g ﬂ Customize the Quick Access Toolbar,
Chooue commands from: Cuptomize Quick Access Toolbar:

Frecting Fietan & for il omets st =
C||Ck Add s [ Eman a5 POF ttachment - [ e

s Bumai 3 5P Sttachmerd 9 unds v

& ™ Redo I*

3 Hew.. a

Svanted lq Enabi Editing
Document
G Excel adds the command. Cutames Bven Emmmuu

To remove a command, click it. SN ) o onseos

Click Remove. o Mt e

000 0 O
y
i
i

BE

Click OK. 5 ovenneant .

2] Optiont

| RPN
]

0 Quichk Acoess Toolbar below the

@ Excel adds a button for the o J@Wm; R R
command to the Quick Access e c— g L e
My Bl D SA EEWEE S g
Toolbar. P el iiore
P rm——— - T Fyom—— |
Ve
v You can add a button directly
You can move the Quick Access from the Ribbon. Click the
Toolbar below the Ribbon to Ribbon tab that contains the
give it the full width of the command, right-click the
Excel window, so you can add command, and then click Add
many more buttons. Click the to Quick Access Toolbar.
Customize Quick Access Excel inserts a button for the
Toolbar button ([-]) and then command on the Quick Access
click Show Below the Ribbon. Toolbar.
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